
TheMarqueeGroup.com

info@themarqueegroup.com

TheMarqueeGroup.com

info@themarqueegroup.com

Excel 365: Advanced 

Data Analysis
Seminar for

February 2022



C
F
A

 V
a
n

c
o

u
v

e
r 

F
e
b

. 
2
0
2
2

© 2006 The Marquee Group Inc.1

The Marquee Group

Leaders in Financial Modeling Since 2002

• We believe that spreadsheet-based financial models are the most important decision-

making tools in modern finance

• We have developed a framework and discipline for model design, structure and 

development that leads to best-in-class, user-friendly financial models

• We help finance professionals use this framework to turn their models into powerful 

communication tools that lead to better, more effective decisions

TRAINING

The Marquee Group Offering

CONSULTING ACCREDITATION

✓ Instructors have real-world 

experience and a passion 

for teaching

✓ Topics include: Modeling, 

Valuation, Excel, VBA

✓ Courses are interactive

✓ Clients include banks, 

corporations, business 

schools and societies

✓ Services include:

– Model Development

– Model Re-builds

– Model Reviews

– Model Audits

✓ Clients include a wide 

range of companies in 

various industries

✓ Offered by the Financial

Modeling Institute (FMI)

✓ The Marquee Group was 

one of the founders of the 

FMI

✓ FMI administers official 

exams for three levels of 

financial modeling 

certifications
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Stay in touch with us!

2

YOUTUBE

Watch free Excel 

and financial 

modeling videos

INSTAGRAM

Follow our feed 

to keep up with  

Marquee news

LINKEDIN

Follow your 

instructor and our 

company page

WEBSITE

Check out 

events, articles, 

and our blog

THE BENCHMARQ

Subscribe to our 

newsletter for deals 

and announcements

https://www.youtube.com/channel/UCNId4cO27M909Msf_MksVCw
https://www.instagram.com/themarqueegroup_/
https://www.instagram.com/themarqueegroup_/
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The Financial Modeling Institute

SKILL VALIDATION

• Demonstrate financial modeling proficiency to employers and clients

PERSONAL DEVELOPMENT

• Earn certifications that are challenging and revered by the industry

CAREER FLEXIBILITY

• Verify skills that are globally relevant and respected in many industries

LEVEL 1 LEVEL 2 LEVEL 3

✓ Foundational level of certification program

✓ Proficiency in building beginner-to-

intermediate financial models

✓ Skills in design and comprehension of 

finance, business, accounting and Excel

✓ Attainable following successful 

completion of Level 1

✓ Thorough understanding of real-world 

applications of financial modeling

✓ Demonstrated ability in advanced Excel, 

financial analysis, and financial modeling

✓ Highest level of accreditation achievable

✓ Expert in the end-to-end financial 

modeling value chain

✓ Respected thought leader, mentor, and 

contributor to financial modeling 

education

EACH LEVEL IS RECOGNIZED AS ITS OWN QUALIFICATION 
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Access to New Features

• Many of the features discussed in this course are available only in the version of Excel 

included with a Microsoft 365 subscription

− There are various versions of Microsoft 365 in circulation; depending on your subscription details 

you may have a different version

Determining Your Version of Excel

− Under Subscription Product, you must be using a 

version of Microsoft 365 or Office 365 to access many 

of these features

− To use Dynamic Arrays & associated functions

(UNIQUE, SORT, SORTBY, FILTER, SEQUENCE, 

RANDARRAY) – version must be higher than 1911

− To use XLOOKUP & XMATCH: version must be higher

than 2001

Excel 365

➢ File [F] ➢ Account [D]
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Setting Up Your System

• The Options menu in Excel contains many important settings that control the operation 

of the spreadsheets

• One important setting is as follows:

Editing Options

− Turn off “Allow Editing Directly in Cells”
− When this selection is “off” and you edit a cell (F2 key), you will be prompted to edit the formula in 

the formula bar at the top of the screen.  This is optimal.

− Alternatively, when this selection is “on” and you edit a cell, you will be prompted to edit the 
formula directly in the cell.  This can be problematic because the formula may cover up numerous 

other cells on the screen that you want to see while editing the formula.

− The other benefit from keeping this selection “off” is that if you double click on a cell that contains 
a formula, the cursor will jump to the precedent cells (it will only jump to the first cell reference in 

the formula if the first cell in the formula is on a different worksheet).

Excel 365

➢ File [F] ➢ Options [T] ➢ Advanced 
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Setting Up Your System (Cont’d)

• Some other important settings are as follows:

Calculation Options

− Check the “Automatic” box in the Calculation Options section
− This setting ensures that all formulas calculate automatically

− If this option is set to “Manual”, nothing will happen when you enter a formula until you press the 
F9 key to manually recalculate the spreadsheet  

− You may want to set this option to “Manual” if you are working on an extremely large file because 
it could take Excel a few seconds to recalculate the spreadsheet every time you make a change

− Turn off the “Enable Iterative Calculation” check box (the “Iterative” check box should only be 
turned on when you are working on a spreadsheet that contains an intentional circular reference)

• The settings on the “Excel Options” menu affect all spreadsheets that are currently 
open.  Therefore, if a setting is changed, the change will take place on all the Excel files 

that are open.

Excel 365

➢ File [F] ➢ Options [T] ➢ Formulas



Spilled Ranges: The Basics
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• Historically, Excel’s system of cell referencing required entering a reference to a single 
cell or entering formula that refers to a range of cells

− In the example table, entering the reference =B2 would return

63% while entering the formula =AVERAGE(B2:B6) would return 

69%

• Regardless of whether you entered a reference or a formula,

the result would be a single answer in a single cell

• With spilled ranges (newly introduced in Excel 365), users can enter formulas (or 

references) that will result in multiple answers that “spill” out of the cell you entered the 
formula in

− With our example table, entering the reference =A1:B6 in cell 

D1 would return the results to the right

− Note that the formula is only entered into cell D1, the formula

refers to the entire table, which results in an answer that “spills”
out of D1 to fill the range

• This behavior mirrors some of the previous “Array” functionality
in Excel (sometimes known as “CTRL + SHIFT + ENTER” or
“CSE” functions); however, this classic array behavior was not user friendly or flexible

10

What are Spilled Ranges?

A B

1 Name Grade

2 Kelsey 63.0%

3 Connor 72.0%

4 Max 42.0%

5 Cora 87.0%

6 Arman 81.0%

Example Table

D E

1 Name Grade

2 Kelsey 63.0%

3 Connor 72.0%

4 Max 42.0%

5 Cora 87.0%

6 Arman 81.0%

=A1:B6
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Spilled Range Basics

• The formula =A1:B6 is entered in 
cell D1

• When your cursor is in D1, the 
formula bar will display the formula 
in black font

=A1:B6

A B C D E

1 Name Grade Name Grade

2 Kelsey 63.0% Kelsey 63.0%

3 Connor 72.0% Connor 72.0%

4 Max 42.0% Max 42.0%

5 Cora 87.0% Cora 87.0%

6 Arman 81.0% Arman 81.0%

Example Table

• The other cells are spilled results 

from the formula in cell D1

• When your cursor is in any of 

these cells, the formula bar will 

display the formula cell D1, but it 

will be in grey font

=A1:B6

• The formula can ONLY be edited 

in cell D1

• Excel outlines the extent of a spilled range 

with a blue line when your cursor is in a 

cell within the spilled range

• Spilled results will never overwrite existing 

information in a spreadsheet

− If there is information in the way, the formula 

will return a #SPILL error
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Spilled Range Errors

• Using Spilled Ranges may result in #SPILL errors when a formula returns multiple 

results (an array) and Excel cannot return the results to the spreadsheet for one of the 

following reasons:

− The spill range isn't blank

− The size of array is volatile (i.e. a random number is generating the array)

− The result extends beyond the worksheet’s boundaries
− The formula is in a Table; currently, spilled ranges cannot be used in a Table, but spilled ranges 

can refer 

to a Table

− The result is too 

large and Excel 

has run out of 

memory

− The result is 

spilling into 

merged cells

− Any other error 

preventing the 

display of spilled 

formula results

A B C D E F G

1 Name Grade SPILL RANGE IS NOT BLANK

2 Kelsey 63.0%

3 Connor 72.0% #SPILL! -> =A1:B6

4 Max 42.0%

5 Cora 87.0% SPILLING OFF THE SHEET

6 Arman 81.0%

7 #SPILL! -> =A:A

8 SPILLED RANGE IS IN A TABLE

9 SPILLING INTO A MERGED CELL

10 Values Formulas

11 1 #SPILL! -> =A1:B6 #SPILL! -> =A1:B6

12 2 #SPILL! -> =A1:B6

13 3 #SPILL! -> =A1:B6 THIS IS A MERGED CELL

Example Table
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Spilled Range Operator (#)

• Spilled ranges are a dramatic change to Excel’s functionality that created a need for 
new ways to refer to these spilled ranges

− Microsoft has introduced two modifiers to help users harness spilled ranges in spreadsheets

• The Spilled Range Operator (#) allows you to write formulas that apply to an entire 

spilled range regardless of whether the extent of that range grows or shrinks

• Adding a “#” after a cell reference will refer to the value in that cell along with all the 

values that are spilling out of that cell with a single reference

A B C D

1 Name Grade

2 Kelsey 63.0% 63.0%

3 Connor 72.0% 72.0%

4 Max 42.0% 42.0%

5 Cora 87.0% 87.0%

6 Arman 81.0% 81.0%

Example Table D2 = B2:B6

• Cell D2 contains a spilled range

=AVERAGE(D2#)

• This function will return 69%; the spilled range operator tells excel to 

refer to the entire spilled range which will include all of the values that 

spill out of cell D2

• If the spilled range changes in the future to include additional or less 

data, this function will automatically update to reflect the changes to 

the spilled range
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Implicit Intersection Operator (@)

• Along with the Spilled Range Operator, Microsoft introduced the Implicit Intersection 

Operator (@) to return a single value when it would otherwise return a spilled result

• If you add an “@” sign before a reference that would have returned a Spilled Range and 
Excel will return a result using the following logic:

− If the value is a single item, then return the item;

− If the value is a range, then return the value from the cell on the same row or column as the 

formula;

− If the value is an array, then pick the top-left value.

• The Implicit Intersection Operator is a way to force Excel to behave as it did prior to the 

introduction of Spilled Ranges

A B C D

1 Name Grade

2 Kelsey 63.0% 63.0%

3 Connor 72.0% 72.0%

4 Max 42.0% 42.0%

5 Cora 87.0% 87.0%

6 Arman 81.0% 81.0%

Example Table D2 = B2:B6

• Cell D2 contains a spilled range

=@D2#

• This function will return a single value that will depend on the row in 

which it is entered:

– If entered anywhere on row 2 it will return 63%, if entered on row 5 it will 

return 87%, etc.

– If entered in any row outside of row 2-6 the function will return a #VALUE 

error (there is no value on the same row)



New Excel 365 Functions
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New Functions in Excel 365

• Microsoft has introduced several new functions to Excel 365, however, users must

subscribe to Excel 365 (otherwise these functions are not available)

− Detail on each function is available on subsequent pages

Functions That Return Dynamic Arrays

Other New Functions

Function Description

=SEQUENCE Returns a list of sequential numbers in an array with the ability to specify the characteristics of that sequence

=RANDARRAY Returns an array of random numbers with the ability to specify the characteristics of those numbers

=UNIQUE Returns a list of unique values in a range

=FILTER Returns all records from a selected array filtered for a specific item

=SORT Sorts the contents of a range or array with the ability to specify which column to sort on and what order to sort in

=SORTBY Sorts the contents of a range or array by the values in one or more corresponding ranges or arrays with the ability to 

define primary, secondary, etc. sort criteria to break ties

Function Description

=XLOOKUP A modern, more flexible replacement for the HLOOKUP, VLOOKUP & LOOKUP functions; used to look for specific 

entries (whether they be the contents of a cell, or the contents of an entire row or column) within a large table

=XMATCH A modern replacement for the MATCH function; returns the relative position of a specified item withing an array or 

range

=LET Assigns a name to the results of a calculation allowing intermediate calculations and simplification of large complex 

formulas (the name will only exist withing that specific formula)
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SEQUENCE Function

• Microsoft has introduced new functions that allow you to generate large ranges of 

random or sequential data taking advantage of spilling behavior

• SEQUENCE is used to generate an array of sequential data with a defined height & 

width, starting number and step value

=SEQUENCE(rows, [columns], [start], [step])

The SEQUENCE function has 4 arguments:

rows: The number of rows that the spilled range will contain; this is a required 

argument

columns: The width of the spilled range of data; if this argument is omitted, Excel will 

return results one column wide by default

start: The first number in the sequence

step: This is the “step value” or the amount that Excel will increment by when 
generating the series of sequential data

A1 = SEQUENCE(6)

• In the simplest form, SEQUENCE will return a series of numbers 

starting at 1 and counting by 1 for a defined number of columns

C1 = SEQUENCE(6,2,2,2)

• This version counts by 2 (starting at 2) and generates a sequence 6 

rows x 2 columns; note that when you are returning multiple columns, 

Excel will move from left to right then from top to bottom when 

generating the sequence

Example Table

A B C D

1 1 2 4

2 2 6 8

3 3 10 12

4 4 14 16

5 5 18 20

6 6 22 24
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RANDARRAY Function

• RANDARRAY is used to generate arrays of pseudo-random numbers

− Note that the RANDARRAY function is volatile and will calculate new random numbers every time 

a spreadsheet recalculates

=RANDARRAY([rows], [columns], [min], [max], [integer])

The RANDARRAY function has 5 arguments; all of them are optional:

rows: The number of rows that the spilled range will contain; if this argument is 

omitted, Excel defaults to one row

columns: The width of the spilled range of data; if this argument is omitted, Excel 

defaults to one column

min: The lowest possible random number; if this argument is omitted, Excel 

defaults to a min of 0

max: The highest possible random number; if this argument is omitted, Excel 

defaults to a max of 1

integer: To return integer values, type TRUE.

To return decimal values, type FALSE (or omit)

A B C D

1 0.5447 2 1

2 4 3

3 6 1

4 4 6

5 6 3

6 3 4

Example Table

A1 = RANDARRAY()

• In the simplest form, RANDARRAY will return a random decimal 

number between 0 and 1; this duplicates the older =RAND() function

C1 = RANDARRAY(6,2,1,6,TRUE)

• This RANDARRAY will return a series of dice rolls (integers between 

1 and 6) that is six rows by 2 columns
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• UNIQUE is used to generate a list of unique values in a range (or to eliminate 

duplicates)

=UNIQUE(array, [by_col], [exactly_once])

19

UNIQUE Function

A B C D

1 Kelsey Kelsey Kelsey

2 Connor Connor Cora

3 Max Max

4 Max Cora

5 Cora

6 Connor

Example Table

The UNIQUE function has 3 arguments:

array: The range or array from which to return unique rows or columns

by_col: To compare rows against each other and return unique rows, type FALSE (or 

omit).

To compare columns against each other and return unique columns, type 

TRUE.

exactly_once: To return all distinct rows or columns from the array (i.e. eliminate duplicates), 

type FALSE (or omit).

To return rows or columns that occur exactly once from the array, type TRUE.

C1 = UNIQUE(A1:A6)

• In the simplest form, UNIQUE will list each name that appears in the 

list once; the returned list will be sorted in the same order they appear 

in the original list

D1 = UNIQUE(A1:A6,,TRUE)

• This returned list only includes only the names appear exactly once in 

the original list (i.e. Max & Connor both appear twice in the original list 

and are excluded)
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SORT Function

• SORT can be used to re-order a list in ascending order based on the contents of a 

particular column (or row)

=SORT(array, [sort_index], [sort_order], [by_col])

The SORT function has 4 arguments:

array: The range or array to sort

sort_index: An integer indicating the row or column number to sort the array based on 

(i.e. to sort based on the first row you would enter a 1)

sort_order: To sort based on ascending order (or A->Z for text information) in the sort 

index column, enter a 1 (or omit).

To sort based on descending order (or Z->A for text information) in the sort 

index column, enter a -1.

by_col: To sort by row, enter FALSE (or omit).

To sort by column, enter TRUE.

A B C D E F G

1 Student Course Grade

2 Kelsey Math 75% Kelsey Gym 93%

3 Connor Physics 85% Connor Physics 85%

4 Arman Gym 80% Arman Gym 80%

5 Connor Math 68% Arman Physics 78%

6 Kelsey Gym 93% Kelsey Math 75%

7 Arman Physics 78% Connor Math 68%

Example Table

E2 = SORT(A2:C7,3,-1,FALSE)

• Results are sorted based on the 3rd column in 

the array (column C) in descending order
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FILTER Function

• FILTER is a powerful function that returns all records from a selected array filtered for a 

specific item

=FILTER(array, include, [if_empty])

A B C D E F G

1 Student Course Grade

2 Kelsey Math 75% Kelsey Math 75%

3 Connor Physics 85% Connor Math 68%

4 Arman Gym 80%

5 Connor Math 68% no results found

6 Kelsey Gym 93%

7 Arman Physics 78%

Example Table E2 = FILTER(A2:C7,B2:B7=“Math”,“no results 
found”)
• FILTER can quickly extract simple subsets; in 

this case it is extracting all records where the 

course is equal to Math

E5 = FILTER(A2:C7,B2:B7=“English”,“no 
results found”)
• The “if_empty” argument can be helpful to avoid 

error messages when no valid results can be 

found with FILTER

The FILTER function has 3 arguments:

array: The range or array to filter

include: The criteria to be used to filter the array; technically, an array of boolean 

(TRUE or FALSE) values representing rows or columns to retain

if_empty: What the function should return if no results are found
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FILTER Function with AND / OR Logic

• The FILTER function can be used to generate more complicated filtered lists by relying 

on mathematical manipulation of the TRUE/FALSE values within the “include” argument
• To understand how this works, we must understand what is happening within the 

“include” argument on the previous page
− On the prior page, the “include” argument B2:B7=“Math” will return the array 

{TRUE, FALSE, FALSE, TRUE, FALSE, FALSE}

− The FILTER function returns a list containing rows where the value = TRUE based on this array

• To create more complex FILTER functions, we can take advantage of how addition & 

multiplication of boolean values is handled in Excel

Multiplication of Boolean (AND Logic) Addition of Boolean (OR Logic)

TRUE x TRUE = TRUE TRUE + TRUE = TRUE

TRUE x FALSE or FALSE x TRUE = FALSE TRUE + FALSE or FALSE + TRUE =  TRUE

FALSE x FALSE = FALSE FALSE + FALSE = FALSE

A B C

1 Student Course Grade

2 Kelsey Math 75%

3 Connor Physics 85%

4 Arman Gym 80%

5 Connor Math 68%

6 Kelsey Gym 93%

7 Arman Physics 78%

Example Table

FILTER(A2:C7,((B2:B7=“Math”)+(B2:B7=“Physics”)),“no results found”)
• Relying on boolean addition to return items where Course = Math OR Course = Physics; 

this function would return a list including Kelsey & Connor’s Math results + Connor & 
Arman’s Physics results

FILTER(A2:C7,((B2:B7=“Math”)*(A2:A7=“Connor”),“no results found”)
• Relying on boolean multiplication to return items where Course = Math AND Name = 

Connor; this function would return a list including only Connor’s Math results



C
F
A

 V
a
n

c
o

u
v

e
r 

F
e
b

. 
2
0
2
2

© 2006 The Marquee Group Inc.23

SORTBY Function

• SORTBY has similar functionality to SORT (i.e. to re-order a list in ascending or 

descending order based on the contents of a particular column (or row))

− SORTBY permits secondary sort criteria to create the desired ordering when there are ties (i.e. if 

there are multiple grades for each student)

=SORTBY(array, by_array1, [sort_order1], …)
The SORTBY function has 3 mandatory arguments:

array: The range or array to sort

by_array1: The range or array to sort based on

sort_order1: To sort based on ascending order (or A->Z for text information) in the 

by_array1 array, enter a 1 (or omit).

To sort based on descending order (or Z->A for text information) in the 

by_array1 array, enter a -1.

by_array2, sort_order2, 

etc.

Additional secondary, tertiary, etc. arrays to sort based upon

A B C D E F G

1 Student Course Grade

2 Kelsey Math 75% Kelsey Gym 93%

3 Connor Physics 85% Arman Gym 80%

4 Arman Gym 80% Kelsey Math 75%

5 Connor Math 68% Connor Math 68%

6 Kelsey Gym 93% Connor Physics 85%

7 Arman Physics 78% Arman Physics 78%

Example Table

E2 = SORTBY(A2:C7,B2:B7,1,C2:C7,-1)

• Results are sorted first based upon Course (from A-

>Z) then within each Course based upon Grade 

(from highest to lowest)

• The SORT function could sort based on Course, but 

the entries within each Course would appear in the 

order in which they occur in the original list
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SORTBY Function (Cont’d)

• One of the limitations of the SORT function is that it will always return the full array 

(sorted by the sort_index, which must be part of the array)

− In the example table, perhaps we didn’t want to sort the full table, we just wanted to return the 
names, sorted by Course and then Grade

• With SORTBY, the by_arrays do not need to be a part of the array

− The result is that we do not need to return the data which our source is based upon

E2 = SORTBY(A2:A7,B2:B7,1,C2:C7,-1)

• Results are sorted first based upon Course (from A->Z) then within each 

Course based upon Grade (from highest to lowest)

• A key advantage of SORTBY vs. SORT is that SORTBY allow you to 

separate the return range (array) from the arrays which the function is 

sorting based on (the by_arrays)

Example Table

A B C D E

1 Student Course Grade

2 Kelsey Math 75% Kelsey

3 Connor Physics 85% Arman

4 Arman Gym 80% Kelsey

5 Connor Math 68% Connor

6 Kelsey Gym 93% Connor

7 Arman Physics 78% Arman
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XLOOKUP Function

• XLOOKUP can be used to look for specific entries (whether they be the contents of a 

cell, or the contents of an entire row or column) within a large table

=XLOOKUP(lookup_value, lookup_array, return_array, [if_not_found], 

[match_mode], [search mode])

− XLOOKUP searches for a specified value in a specified array, and then returns a value in the 

same row or column from an array that you specify

The XLOOKUP function has 4 main arguments:

lookup_value: The item you are searching for within the lookup array

lookup_array: The range or array to search for the lookup_value within

return_array: The range or array from which to return results

if_not_found: The value returned if no match is found; if no value is entered for this 

argument and the lookup_value is not found in the lookup_array, the function 

will return a #N/A error

A B C D

1 Employee Division Wage/hr Status

2 John Finance $42.00 FT

3 Peter Production $33.00 FT

4 Miranda Marketing $75.00 Contract

5 David HR $40.00 PT

6 Katie Production $30.00 FT

7 Sarah Purchasing $26.00 PT

Example Table =XLOOKUP(“Katie”,A1:A7,C1:C7)
• This function will return $30.00.  It will search for the word “Katie” in A1:A7 

and then return the corresponding Wage/hr in C1:C7

=XLOOKUP(“Tim”,A1:A7,C1:C7,“invalid entry”)
• This function will return “invalid entry” because it cannot find “Tim” in A1:A7

=XLOOKUP(“Status”,A1:D1,A4:D4)
• This function will return Contract; lookup_arrays for XLOOKUP can be rows 

OR columns making XLOOKUP a potential replacement for the VLOOKUP 

or HLOOKUP functions
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XLOOKUP Function (Cont’d)

• In addition, XLOOKUP has 2 additional modifiers to change how it searches for 

lookup_value within lookup_array:

match_mode: If match_mode = 1, XLOOKUP finds the smallest value that is greater than or 

equal to lookup_value; lookup_value must be sorted in descending order: 

...2, 1, 0, -1, -2,..., Z-A

If match_mode = 0 (or the argument is omitted), XLOOKUP finds the first 

value that is exactly equal to lookup_value; lookup_array can be in any order

If match_mode = -1, XLOOKUP finds an exact match or the largest value that 

is less than or equal to lookup_value; lookup_array must be placed in 

ascending order: ...-2, -1, 0, 1, 2, ..., A-Z

If match_mode = 2, XLOOKUP will look for matches using Excel’s wildcard 
characters (?, * and ~)

CAUTION: the match mode arguments for XLOOKUP are the opposite of 

those in the previous MATCH function, so be careful when specifying 

approximate matches

search_mode: If search_mode = 1 (or the argument is omitted), XLOOKUP performs a 

search starting at the first item

If search_mode = -1, XLOOKUP performs a search starting at the last item

If search_mode = 2, XLOOKUP performs a search using a faster binary 

search that relies on lookup_array being sorted in ascending order

If search_mode = -2, XLOOKUP performs a search using a faster binary 

search that relies on lookup_array being sorted in descending order
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XLOOKUP Function (Cont’d)

• XLOOKUP isn’t limited to returning a single result from a single cell in a table, it can 
also take advantage of the new spilled range behavior to return an entire row or column 

of the return_array

− If the return_array covers multiple rows or columns (rather than a single row or column), the 

XLOOKUP function will return a full row or column as a spilled range

• In addition, XLOOKUP combines the functionality of VLOOKUP and HLOOKUP; it can 

look vertically or horizontally depending on the orientation of the lookup_array and the 

return_array

A B C D E F

1 Employee Division Wage/hr Status Wage/hr

2 John Finance $42.00 FT $42.00

3 Peter Production $33.00 FT $33.00

4 Miranda Marketing $75.00 Contract $75.00

5 David HR $40.00 PT $40.00

6 Katie Production $30.00 FT $30.00

7 Sarah Purchasing $26.00 PT $26.00

8

9 David HR $40.00 PT

Example Table

A9=XLOOKUP(“David”,A1:A7,A1:D7)
• This function returns the entire “David” row from the table; it 

searches for “David” in A1:A7 and returns every value in that 
row in the range A1:D7

F1=XLOOKUP(“Wage/hr”,A1:D1,A1:D7)
• This function returns the entire “Wage/hr” column from the 

table: it searches for “Wage/hr” in A1:D1 and returns every 
value in that column in the range A1:D7
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XLOOKUP Overcomes Many Shortcomings of VLOOKUP

• There are several reasons why a VLOOKUP function may not return the correct result 

(there is a page with details on VLOOKUP later in this presentation)

• Microsoft has long recognized many of the limitations of VLOOKUP and has spent 

many years designing XLOOKUP to overcome these pitfalls

28

Pitfall of VLOOKUP Function How XLOOKUP Solve This Issue

• The lookup_value and the cell that contains the data you are 

looking to extract must both be within the table_array

• XLOOKUP separates the lookup_array and the return_array so 

that a full table_array no longer needs to be referenced

• The cell that contains the data you are looking to extract must be 

located to the right of the lookup_value

• XLOOKUP does not care about the relative position of the 

return_array vs. the lookup_array

• The VLOOKUP function is most helpful when there are no 

repetitive instances of the lookup_value in the leftmost column of 

the table_array

• This is still an issue with XLOOKUP, however, the added ability 

to search from the last item to first item with search_mode adds 

some flexibility

• table_array will not automatically expand when more data is 

added to the table in which you are searching

• This is still a limitation of XLOOKUP, however, the use of the 

Table Tool can overcome this (see later in this  presentation)

• col_index_num should be automated in case any columns are 

inserted or deleted within the table_array

• A col_index_num is no longer necessary, XLOOKUP asks you to 

explicitly define the return_array (which will move when columns 

are inserted or deleted)

• range_lookup can either return a close match (TRUE) or an 

exact match (FALSE)

• This functionality still exists, but XLOOKUP has changed to 

select “exact match” as the default match_mode to limit 
unintentional approximate results

• Looking vertically (rather than horizontally) requires the use of a 

separate function (HLOOKUP)

• XLOOKUP can look vertically or horizontally depending on the 

orientation of lookup_array and return_array
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XMATCH Function

• The XMATCH function returns the relative position of an item within a table of data that 

matches a specific value in a specified order

=XMATCH(lookup_value, lookup_array, [match_mode], [search_mode])

− XMATCH provides similar functionality to the legacy MATCH function, but adds wildcard search 

features and control over search mode

− A key benefit of XMATCH (vs. MATCH) is that there is a default match_mode (i.e. the match 

mode is set to exact match by default and one less argument must be entered)

The XMATCH function has 4 arguments:

lookup_value: The item you are searching for within the lookup array

lookup_array: The range or array to search for the lookup_value within

match_mode: Identical match modes to the XLOOKUP function.  

NOTE: These are the opposite of the older MATCH function!

search_mode: Identical search modes to the XLOOKUP function.

A B C D

1 Employee Division Wage/hr Status

2 John Finance $42.00 FT

3 Peter Production $33.00 FT

4 Miranda Marketing $75.00 Contract

5 David HR $40.00 PT

6 Katie Production $30.00 FT

7 Sarah Purchasing $26.00 PT

Example Table

=XMATCH(“Miranda”,A1:A7)
• This function will return the number 4; it will search for the word “Miranda” 

in A1:A7, “Miranda” is the 4th item in this list

=XMATCH(“Division”,A1:D1)
• This function will return the number 2; it will search for the word “Division” in 

A1:D1, “Division” is the 2nd item in this list
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LET Function

• The LET function allows the user to set a variable and use such variable in another 

calculation

− This may allow for more understandable formulas in certain circumstances

=LET(name1, name_value1, …, calculation)

− Note that multiple names can be applied with the LET function; just enter additional names and 

values separated by commas after name_value1 and before calculation

− Names assigned by a LET function only apply within the LET function and cannot be referenced 

in other cells or functions within Excel; if you want to refer to something in other cells or functions, 

you should use Static Naming (i.e. Formulas -> Define Name -> Define Name)

• EXAMPLE: =LET(x, 3, y, 5+7, x * y) -> this function returns 36; x = 3, y = 12, x * y = 36

The LET function has a minimum of 3 arguments:

name1: The name you are applying to the first variable; names must start with a 

letter, cannot be the output of a formula, or conflict with a range

name_value1: The value associated with a name, this can be an entered value, a range, a 

function or a calculation

calculation: The formula to be evaluated using the applied names



Old Tools with New Uses
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OFFSET Function

• The OFFSET lookup function is also extremely useful at extracting information and can 

be used to create summary tables

= OFFSET(Reference, Rows, Cols, Height, Width)

− OFFSET returns a reference to a cell that is a specified number of rows and columns from a 

reference cell.

A B C

1 Name University Age

2 Michelle Western 24

3 Paul McGill 32

4 Ken Queens 21

5 Cindy Western 26

Example Table
=OFFSET(A1,2,1)

• This function will return McGill, because 

it will start at the reference cell (A1), drop 

down 2 rows, move to the right 1 column and 

retrieve the contents of the destination cell

The OFFSET function has 3 mandatory arguments:

Reference:
The reference cell (also known as the “anchor” cell) from which the offset 
function is based

Rows: The number of rows, up or down, that you want to move from the reference cell

Cols:
The number of columns, to the left or right, that you want to move from the 

reference cell

32
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OFFSET Function – Height & Width Arguments

• OFFSET has some interesting applications that work well with Excel’s new Spilled 
Range functionality

− There are two optional arguments to the OFFSET function that allow you to create a spilled 

range:

−

• The use of OFFSET in conjunction with MATCH or XMATCH will can allow you to 

extract a specific range of data from a larger data set

− For example, you could use a combination of OFFSET and XMATCH to extract pricing data for 

the last x days beginning at any point in time (by using XMATCH to find the correct row in a larger 

pricing dataset and using a negative height argument to extract the previous x entries)

E2=OFFSET(A1,2,1,1,2)

• The addition of a height & width argument creates 

a spilled range; Excel will start at the reference cell 

(A1), drop down 2 rows, move to the right 1 

column and retrieve an array 1 row high x 2 

columns wide starting in that cell

33

Optional OFFSET Arguments

height: The height (in number of rows) that you want the results to be; same as the 

reference if omitted

width: The width (in number of columns) that you want the results to be; same as 

the reference if omitted

A B C D E F

1 Name University Age

2 Michelle Western 24 McGill 32

3 Paul McGill 32

4 Ken Queens 21

5 Cindy Western 26

Example Table
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VLOOKUP Function

• While Microsoft expects that XLOOKUP will ultimately replace VLOOKUP, VLOOKUP 

remains the most popular lookup function widely in use today

= VLOOKUP(Lookup_value, Table_array, Col_index_num, Range_lookup)

− VLOOKUP (vertical lookup) searches for a value in the leftmost column of a table, and then 

returns a value in the same row from a column you specify

A B C

1 Name University Age

2 Michelle Western 24

3 Paul McGill 32

4 Ken Queens 21

5 Cindy Western 26

Example Table
=VLOOKUP(“Ken”,A1:C5,3,False)
• This function will return 21, because it will 

search for the word “Ken” in column A and 
then return the corresponding age in the third 

column

The VLookup function has 4 arguments:

Lookup_value: This is the item you are searching for.  This item must be found in the leftmost 

column of the Table_array.

Table_array: The entire table in which you are searching for the data.

Col_index_num: When Excel finds the item you are searching for (the Lookup-value) in the 

leftmost column of the table (the Table_array), it will move a certain number 

of columns to the right to extract the data that you are looking to retrieve.

Range_lookup: To find a close match, type TRUE (or omit).

To find an exact match, type FALSE.

34
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VLOOKUP Function (Cont’d) – Returning Multiple Columns

• One of the benefits of the XLOOKUP function is that can return an array of data (rather 

than a single value); this can be helpful when we want to return an entire row of data 

with a single formula

− One limitation is that XLOOKUP (without using more complicated functions) will only return data 

with columns in the order they appear in the source data

• With the use of an array constant in a VLOOKUP function, we can tell Excel to return 

multiple columns of data (a spilled range) in any order that we define

− An array constant is an array of data contained within {..} symbols (i.e. {1,2} is an array constant)

− Excel can handle an array constant in the col_index_num argument to return multiple columns in 

any order that you specify

A B C

1 Name University Age

2 Michelle Western 24

3 Paul McGill 32

4 Ken Queens 21

5 Cindy Western 26

6

7 Cindy 26

8

9 21 Queens Ken

Example Table

A7=VLOOKUP(“Cindy”,A1:C5,{1,3},FALSE)
• This function searches for the word “Cindy” in 

column A and then return the corresponding name 

and age (the first and third column)

A9=VLOOKUP(“Ken”,A1:C5,{3,2,1},FALSE)
• This function searches for the word “Ken” in 

column A and then returns the corresponding age, 

university and name in that order (these are the 

third, second and first columns, respectively)
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Table Tool

• A Table (previously known as a List) can be created to manage and analyze data

− The Table can perform powerful calculations on a dataset:

− The Table will automatically expand datasets when new data is added allowing for dynamic calculations

− Tables also automate the expansion of any included formulas that are used within the data set

− Note – Tables do not provide as much flexibility in managing data as Dynamic Named Ranges (see 

previous slides) 

• The steps to run the Table Tool are as follows:

− In the menu box that appears, fill in the following information:

− Where is the data for your table?:  On a worksheet, 

select the range of cells to be included in the table. 

The cells can be empty or can contain data.

− My Table has headers:  If the selected range 

contains data to be displayed as table headers, 

select the “My table has headers” check box.
− Keyboard shortcut: Ctrl+T or Ctrl+L

Excel 365

➢ Insert [N] ➢ Table [T]
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Table Tool (Cont’d)

• Once a Table is created, the Table Tools become available in the ribbon, and a Design 

tab is displayed 

− Tools on the Design tab can be used to customize or edit the Table

− Note that the Design tab is only visible when a cell in the Table is selected

• Formatting of a Table can be completed in the following way:

− Place the cursor within the Table and access Table Styles:

− Table Style Options has additional formatting options:

− Header Row: Turns the header row on or off

− Total Row:  Turns the total row on or off

− Banded Rows:  Displays even and odd rows differently

− First Column:  Displays special formatting for the first column

− Last Column:  Displays special formatting for the last column

− Banded Columns:  Displays even and odd columns differently

Excel 365

➢ Design [JT] ➢ Table Styles [S]
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Table Tool (Cont’d)

• Convert the Table to a regular range of data in the worksheet to stop working in a Table 

format

− To convert without losing any Table style formatting that was applied:

− Click anywhere in the Table – this displays the Table Tools, adding the Design tab

− On the Design tab, click Convert to Range and then click Yes.

− To convert with no Table style formatting it is necessary to first remove the Table style formatting:

− Click anywhere in the Table – this displays the Table Tools, adding the Design tab 

− On the Design tab, open Table Styles and remove formatting by selecting Clear

− Use the Convert to Range tool to convert the table back to a normal range of cells

− If you no longer want to work with a Table or the data that it contains, you can delete it

− Select a Table, highlight the entre Table (including the Table header), press DELETE

Excel 365

➢ Design [JT] ➢ Convert to Range [G]

Excel 365

➢ Design [JT] ➢ Table Style [S] ➢ Clear [C]
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Structured Reference Functions

• Structured references make it much easier and more intuitive to work with Table data 

when you are using formulas that reference a Table

= CALCULATION(Table[Column_specifier])

− Useful because Table data ranges often change and the cell references for structured references 

adjust automatically 

− Minimizes the need to rewrite formulas as rows and columns are added and deleted in a table, or 

when external data is refreshed.

=COUNT(Table1[Age])

• This function returns 4, because 

there are four people listed in Table 1

The Structured Reference Functions have 3 arguments:

CALCULATION: The mathematical calculation you wish to preform (i.e., SUM, COUNT, etc.)

Table: A meaningful name that you provide to reference the actual Table data 

(excluding the headers row and totals row, if any)

Column_specifier: Derived from the column header, enclosed in brackets, and references the 

column data (excluding the column header and total, if any)

A B C

1 Name University Age

2 Michelle Western 24

3 Paul McGill 32

4 Ken Queens 21

5 Cindy Western 26

Table 1



C
F
A

 V
a
n

c
o

u
v

e
r 

F
e
b

. 
2
0
2
2

© 2006 The Marquee Group Inc.40

Structured Reference Functions (Cont’d)

• Special item specifiers can also be used to refer to various portions of a Table, such as 

the Totals row, to make it easier to refer to these portions in formulas. 

− The following are the special item specifiers that you can use in a structured reference:

• Structured references & tables can be very useful when dealing with some of Excel’s 
new functionality – for example, when using the XLOOKUP function

#All Returns the entire contents of the Table, including column headers, data, and 

totals (if any)

#Data Returns the data cells of the Table

#Headers Returns the column headers of the Table

#Total Returns the total rows for the Table. If none exists, then it returns null

@-ThisRow Just the portion of the columns in the current row. @-ThisRow cannot be 

combined with any other special item specifiers. Use it to force implicit 

intersection behavior for the reference or to override implicit intersection 

behavior and refer to single values from a column.

=XLOOKUP(“Ken”,Table1[Name],Table1[Age])
• This function returns 21; Excel searches the Name 

column for “Ken” and returns the corresponding entry 
from the “Age” column of the table

A B C

1 Name University Age

2 Michelle Western 24

3 Paul McGill 32

4 Ken Queens 21

5 Cindy Western 26

Table 1
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